Online Photo Galleries : QuickStart Guide
Welcome! This booklet was designed to assist you, the photographer, in making the most of all
that your Online Photo Galleries service has to offer! The tips and suggestions enclosed are
designed to help you present your work and your company in the best light possible so that you
can expand your business, increase your sales, and be on the cutting edge of all that is new and
innovative in the photographic industry!
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1-Customizing the Appearance of Your Online Galleries Account
No online gallery is complete without custom-created page styles, photographer's logo,
customized photographer gallery page, and custom-created watermark! All of these features may
be accessed through the “Settings” tab in your Online Galleries account.
Create a Style, or Select a Default Style
At the bottom of the Photographer Information page you will find a drop-down box which allows
you to select the default style for your gallery pages. There are several standard styles to choose
from, or you can create your own. The default style you choose will automatically be applied to
each gallery you create unless you dictate otherwise when you create the gallery. The style of
any gallery may be changed at any time. If you would like to create your own style with unique
colors and fonts, click on the “Settings” subtab: “Styles.” You will be prompted to name your
custom style and to select your preferred colors and fonts. Once you have previewed and saved
this style, you may make this style your default style through the Photographer Information page,
or you may select it for a specific gallery page through that gallery's “Gallery Information Page.”
More detailed information may be found on pages 7, and 8 of this guide.
Attach Your Logo
Using Photoshop or another graphics program, create a new logo or modify your current logo to
blend with your online gallery pages. The recommended logo size is 100 pixels high. Larger
logos may affect the appearance of your gallery pages and the placement of your images.
Customize Login Page
By default, when your customer is directed to the Online Galleries gallery log in page, the page is
blank with only the log in box and some text present. You can customize the look of this page by
clicking on the “Settings” sub tab: “Customize Gallery Page.” If you have a message you would
like to share with every customer who arrives at the log in page, you may type that text in the text
box. You may also check or uncheck the boxes at the bottom of this page to determine which
pieces of contact information will be viewed by your customers. Best of all, you may attach a
Photographer Gallery Page Image. We call this a “marquee image,” as it should be a single JPG
photograph or a collage of photographs that represent the spirit of the work that you provide.
Using Photoshop, you may prepare a single image, or create a collage of images, and upload a
single JPG file. The recommended Photographer Gallery Page Image size is no larger than 500
pixels wide or high.
Create a Watermark
FIRST: At the bottom of your Photographer Information page under the “Settings” tab, check the
“Watermark Enabled” box. You have three options for watermarking and copyright-protecting
your images.
1. Add a Text Watermark through Online Galleries
2. Add a Watermark Image through Online Galleries
3. Watermark with Photoshop or an alternate program

NOTE: A Watermark is not required in order to use Online Galleries. We highly recommend the
use of Watermarks in order to protect your images from copyright violation. If you choose NOT to
use the Text Watermarking feature, you will need to A) check the “Watermark Disabled” box or B)
erase the text from the “Watermark Text” box so that the Text Watermark will not appear
alongside your other watermark.
A Text Watermark is the most basic watermark, and is also the easiest to apply. Simply type your
preferred text into the “Watermark Text” box. We recommend text that will clearly define who you
are, such as “www. Photostudio .com” or “copyright smith photo.”
A Watermark Image is a customized watermark that can be scaled to fit images of any size. This
watermark may be text only, text plus graphics, or graphics only. Design the Watermark Image in
Photoshop or another graphics program and save it as a .PNG file. (A .PNG file is a vectorbased file which will not become pixelated as it is scaled to accommodate varying image sizes.
In order to activate this scaling feature you will want to check the “Adjust the size of the
watermark image to fill the picture” box.) We recommend that you create a Watermark Image on
a canvas that is approximately 50 pixels high by 200 pixels wide.
Watermarking with Photoshop or an alternate program can increase the speed with which your
images are uploaded to Online Galleries. The tutorial near the end of this Guide provides
information on watermarking with Photoshop and Photoshop Elements.
2-Preparing to Sell : Prepare Your Shopping Cart
Before you can begin selling, you will need to set-up your online sales system. Determining how
you will collect your revenue, what you will charge for your products, and the shipping options you
will offer will enable you to create a shopping cart that is 100% customized to your studio and
business model.
Collecting Your Revenue
With Online Galleries, you have 2 options for collecting your sales revenue. By default, when
your Online Galleries account is first established, you will be set up to accept only Cash
transactions, allowing you to run test orders through your new Online Galleries account. Please
notify Online Galleries when you are ready to begin selling so we may adjust your Collection
Settings accordingly.
1) Process transactions via your pre-existing merchant account. We can assist you
in setting up an e-commerce payment gateway which will channel your funds
directly into your checking account. A Payment Gateway allows you to process
transactions solely under your business name. A Virtual Terminal is included for
processing credit cards on orders that are submitted by phone or in
writing.(Information regarding Payment Gateway setup was included in your
Online Galleries Photographer Membership Pack.) There is a set-up fee for
Payment Gateways.
2) Process transactions via PayPal. PayPal is NOT just for e-Bay! A PayPal
Business Account -- Website Payments STANDARD – provides a simple means
for accepting credit cards. Your funds may be withdrawn into your checking
account and available to you within days of a transaction. Your customers may
pay with their credit card, or with their PayPal account. NOTE: Customers DO
NOT NEED a PayPal account in order to pay you!
Selecting Your Shipping Options
Click on the “Settings” tab, then click on the sub tab “Shipping.” Here you may determine which
Shipping options you want to provide to your clients. You may wish to call your Shipping option
“USPS 1st Class” or “FedEx.” You may also choose to charge shoppers based on the amount of
the sale (Tiered: $5 for every $50 sold, e.g.), or you may charge a flat rate.
PAYPAL USERS: If/when your account is enabled to accept PayPal-managed transactions, the
Online Galleries Shipping sub-tab will disappear. Your shipping and sales tax options must then

be set through your PayPal Business Account! View the “Profile” tab within PayPal to select your
preferences.
Creating Price Lists
With Online Galleries, you may create and store multiple Price Lists for your different job types,
such as Weddings, Sports Events, and Product Photography.
PRICE LISTS: Your Price List becomes your Shopping Cart once you have associated it with a
Group or Gallery. Begin by clicking the “Add Price List” button below the Price Lists column. You
may name your Price List “Wedding Prices” or “School Package Prices.” Then begin adding
products to your Price List. You may choose to add a Print or Product (prints, calendars, frames,
etc.), a Print Enhancement (sepia toning, borders, vignetting, etc.), Text (display a message to
your shoppers), or a Customer Text Entry Box allowing shoppers to type messages to you (e.g.,
“Please crop vertically” or “I would like the Black Leather instead of the Brown”). You may also
add Sample Images of your products, such as a JPG photo of the keychain or photo-collage you
sell. A finished Price List maybe be duplicated by clicking the “Copy” button beside the Price List
name.
LAST STEP: Return to the “Settings” tab and your “Photographer Information” page. Scroll to
the bottom of the page where you see the drop-down box “Default Price List.” Here you will
select the default Price List for all of your Galleries. (You may also select specific Price Lists for
each individual Gallery you create.)
3-Package Builder
You may wish to offer discounted package-bundles of photos and/or products to your customers.
Our Package Builder feature allows you to create a variety of Package Types.
-Click the “Price Lists” tab within your Online Galleries account.
-Select the “Add PackageGroup” button below the Package Groups column.
-Name your Package Group (e.g. “Wedding Packages” or “School Packages”).
-To create and add custom Packages to this Package Group, select the “Edit Packages” button
beside the Package Group name.
-Click the “Add Package” button to begin.
-After creating a Package Group, you may associate that Package Group to any Price List by
clicking the “Edit” button beside the Price List, then selecting the Package Group to be associated
from the drop-down box.
Variable Packages
A Variable Package allows the photographer to offer a customizable selection of “Sheets”
or “Units”, allows the customer to create a mix-and-match package of differently-sized prints until
the “Sheet” or “Unit” limit has been met.
-Select the Variable option.
-Name the Package (e.g. “The Gold Package”)
-Set the Price for the Package as a whole.
-Enter the Number of Package Units included in this Package. (The value of a Unit/Sheet will be
set later.
-Enter the Maximum Number of Poses the customer will be allowed to select for this Package.
-Check or un-check the box: Pose limitations do not apply to addon products. This feature (when
checked) prevents your customer from selecting additional poses for add-on prints; instead their
add-on print poses must fall within the “Maximum Number of Poses” pre-set by the photographer.
-Type a Description of your Package (e.g. “Select up to 5 Poses to create your Package of 10
Print Units”)

-Upload a Sample Image of the Package (e.g., a JPG files displaying the contents of the
Package) and type a Sample Description of the Item(s).
-Select the “Add” button.
-You will now be looking at the page through which you will define the specific contents of the
Package.
-Select the “Products” button.
-Select the “Add Product” button.
-You must now create a list of the Products from which your customers may select to build their
Packages.
-Type your Package Product Name (e.g. 5X7 Photo)
-Associate the appropriate Lab Product from the drop-down box (if applicable).
-Enter an Item Unit Value – This is the value in Units of the Product. For example, an 8x10 may
have a Unit Value of 3; a 5x7 may have a Unit Value of 2; and a 4x5 may have a Unit Value of 1.
Partial Units and/or percentages may not be used.
-Add a Description of your Product if you feel your customer will need further description.
-Select the “Add Another” button to continue with your Product list. When you are done, click
“Finish.”
-You will now be looking at your Products list for this Package.
-Click the “Packges” sub-tab from the menu-bar to return to the main Package creation page.
-Associate this Package's Package Group to a Price List by clicking the “Edit” button beside the
chosen Price List, then selecting the Package Group to be associated from the drop-down box.
Add-Ons for Variable Packages
Add-Ons are Items/Products that your customers may add to their Packages. For
example, you may wish to offer 8x10s at a discount to a customer purchasing this Package. You
will create “8x10 Photo” as an Add-On item, and set the price. This uniquely-priced 8x10 will only
be available to purchasers of this specific Package. The customers may select Add-On items to
purchase when they are building their Packages.
-Select the Add-Ons button beside the selected Package to create a list of Add-On items the
customer may choose to purchase when building this Package.
TYPE: Print/Product
-Select the Print/Product option.
-Name the Add-On (e.g. “100 Wallet Prints”).
-Set the price for the Add-On.
-Type a Description of the Add-On (e.g. “Purchase with this Package and save $25!”)
-Upload a Sample Image of the Package (e.g., a JPG files displaying the contents of the
Package) and type a Sample Description of the Item(s).
-Associate the Add-On with a Lab Product Price (if applicable).
-Select the “Add Another” button to continue creating your Add-Ons list. When you are done,
click “Finish.”
TYPE: Additional Package Units
-Select the Additional Package Units option.
-Name the Add-On (e.g. “Add 3 Photo Print Units to This Package”).
-Set the price for the Add-On.
-Type a Description of the Add-On (e.g. “Purchase with this Package and save $25!”)
-Upload a Sample Image of the Package (e.g., a JPG files displaying the contents of the
Package) and type a Sample Description of the Item(s).
-Set the Number of Units being offered.
-Select the “Add Another” button to continue creating your Add-Ons list. When you are done,
click “Finish.”
TYPE: Additional Poses
-Select the Additional Poses option.
-Name the Add-On (e.g. “Add 3 More Poses to This Package”).
-Set the price for the Add-On.

-Enter the Number of Poses to be added.
-Type a Description of the Add-On (if applicable)
-Upload a Sample Image of the Package (e.g., a JPG files displaying the contents of the
Package) and type a Sample Description of the Item(s).
-Select the “Add Another” button to continue creating your Add-Ons list. When you are done,
click “Finish.”
Fixed Packages
A Fixed Package contains a pre-set selection of products and/or image sizes, which
cannot be altered through customer selection. Customers may select the poses to be printed,
but not the print sizes, which are pre-set by the Photographer.
-Select the Fixed option.
-Name the Package (e.g. “The Senior Package”).
-Set the Price for the Package as a whole.
-Enter the Maximum Number of Poses the customer may select to complete his/her Package.
-Check or un-check the box: Pose limitations do not apply to addon products. This feature (when
checked) prevents your customer from selecting additional poses for add-on prints; instead their
add-on print poses must fall within the “Maximum Number of Poses” pre-set by the photographer.
-Enter a Package Description (e.g. “Contains 1-8x10, 2-5x7s, 4-4x5s, & 8 Wallets”).
-Select the “Add” button.
-You will now be looking at the page through which you will define the specific contents of the
Package.
-Select the “Products” button.
-Select the “Add Product” button.
-You must now create a list of the Products from which your customers may select to build their
Packages.
-Type your Package Product Name (e.g. 5X7 Photo)
-Associate the appropriate Lab Product from the drop-down box (if applicable).
-Enter the Number of Selections Required – This will determine the quantity of this Product which
must be selected by the customer. For example, if this Package contains 2-5x7s, then the
Number of Selections Required for the 5x7 Photo is “2”.
-Add a Description of your Product if you feel your customer will need further description.
-Upload a Sample Image of the Package (e.g., a JPG files displaying the contents of the
Package) and type a Sample Description of the Item(s).
-Select the “Add Another” button to continue with your Product list. When you are done, click
“Finish.”
-You will now be looking at your Products list for this Package.
-Click the “Packges” sub-tab from the menu-bar to return to the main Package creation page.
-Associate this Package's Package Group to a Price List by clicking the “Edit” button beside the
chosen Price List, then selecting the Package Group to be associated from the drop-down box.
Add-Ons for Fixed Packages
Add-Ons are Items/Products that your customers may add to their Packages. For
example, you may wish to offer 8x10s at a discount to a customer purchasing this Package. You
will create “8x10 Photo” as an Add-On item, and set the price. This uniquely-priced 8x10 will only
be available to purchasers of this specific Package. The customer may select an Add-On item to
purchase when they are building their Package.
-Select the Add-Ons button beside the selected Package to create a list of Add-On items the
customer may choose to purchase when building this Package.
TYPE: Print/Product
-Select the Print/Product option.
-Name the Add-On (e.g. “100 Wallet Prints”).
-Set the price for the Add-On.
-Type a Description of the Add-On (e.g. “Purchase with this Package and save $25!”)
-Upload a Sample Image of the Package (e.g., a JPG files displaying the contents of the

Package) and type a Sample Description of the Item(s).
-Associate the Add-On with a Lab Product Price (if applicable).
-Select the “Add Another” button to continue creating your Add-Ons list. When you are done,
click “Finish.”
TYPE: Additional Poses
-Select the Additional Poses option.
-Name the Add-On (e.g. “Add 3 More Poses to This Package”).
-Set the price for the Add-On.
-Enter the Number of Poses to be added.
-Type a Description of the Add-On (if applicable)
-Upload a Sample Image of the Package (e.g., a JPG files displaying the contents of the
Package) and type a Sample Description of the Item(s).
-Select the “Add Another” button to continue creating your Add-Ons list. When you are done,
click “Finish.”
Enhancements for Fixed and Variable Package Products and Add-ons
Enhancements for Package Products and Add-ons work much like Enhancements in a
Standard Price List, but with a bit more flair. They do not show up as checkboxes to the
customer. Instead, each Enhancement is associated directly to a specific Product or Add-on
Item.
TYPE: Customer Text Entry
-Select the Customer Text Entry option.
-Name the Enhancement (e.g. “Please provide the student's name”).
-Check the Required box if you want the customer to be unable to proceed without filling this field.
-Enter a Description of the Enhancement if applicable (e.g. “This name will be printed on the
photo you have selected”).
-Select the “Add Another” button to add Enhancements to the Product or Add-on. When you are
done, click “Finish.”
TYPE: Drop-down Menu
-Select the Drop-down Menu option.
-Name the Enhancement (e.g. “Select Color Preference”).
-Check the Required box if you want the customer to be unable to proceed without filling this field.
-Enter a Description of the Enhancement if applicable (e.g. “Selection applies to this item only”).
-Enter a comma-separated list of items/options to be displayed in the Drop-down Menu (e.g.
“Color, Sepia, Black & White, Touch of Color”).
-Select the “Add Another” button to add Enhancements to the Product or Add-on. When you are
done, click “Finish.”
4-Uploading Images
Now that your Online Galleries account Customer Login Pages have been customized and
dressed up to best represent you and your company, it's time to upload some images!
If you are uploading images captured through PhotoLynx, Timestone, DP2, DRUMS, or another
data-collection/exporting software, the following instructions may not apply to you. Please
contact Online Galleries for information on using your unique software with our system.
Online Galleries offers three (3) levels of organization for your images:
Folders – may contain more Folders and/or Groups
Groups – contain Galleries
Galleries – contain the Images themselves
Before you can upload images, you must create the Folder, Group, and Gallery to which you will
upload those images.

First click on the “Galleries” tab in your Online Galleries account.
Add a Folder, the outer level of organization. Folders are typically named to provide generic
information about the Groups and Galleries contained within, such as “2006 Portraits.”
Next, add a Group. The Group will contain your Galleries. These Galleries may be linked to one
another so your customers may see all the images by jumping from one Gallery to the next with
only one password. OR the Galleries may be left un-linked, each containing a separate, private
password, enabling the customer to view ONLY the Gallery for which they have the password.
(If you skip the Folder step and instead move directly to creating a Group, then you may move
that Group into a Folder at a later time by using the “Move” tools.)
Here are some examples of how one might utilize Folders and Groups.
Folder Name: School Photography
Group: Jackson High School
Gallery: Winter Ball
Gallery: Homecoming
Gallery: Prom
Folder Name: Weddings
Group: Jones/Smith Wedding 2005
Gallery: Getting Ready
Gallery: Ceremony
Gallery: Reception
Now that you have a Folder and/or Group, and a Gallery, you may upload images.
Click on the “Galleries” tab.
Click the “Galleries” button beside the Group to which you are adding images.
Click on the “Gallery Control Panel” button beside the Gallery to which you are adding images.
Click on the “Upload Images” button, or the “Upload Images NEW!” button.
NOTE: If you are a Mac user, please be sure you are using the Safari web browser!
Online Photo Galleries only accepts images that are FLATTENED JPG FILES.
Upload Images - Basic (Original Uploader Tool)
NOTE: For PC users ONLY, the Basic uploader may resize your images according to the
Maximum Width and Height proportions defined in your Photographer Information form
under the Settings tab. If you do not want your images to be resized by the Online
Galleries interface, you should leave these fields empty.
For faster upload time, you may want to resize your images before uploading them. We
recommend that resized images should be constrained to between 300 and 700 pixels.
You may drag a folder full of images, or select and drag the images themselves. Images
will upload according to file name. If you ADD images to a Gallery that already contains
images, the new images will upload by file name, but will be located at the end of the
Gallery. Added images will NOT be inserted in between existing Gallery images,
regardless of file name. Sequencing your images BEFORE upload will save you time
later.
In the new window, a Java applet will appear. Accept any RAD Inks pop-ups that request
permission. When the blue bullseye appears on your screen, you are ready to drag and drop
your folder of images into the webpage.
NOTE: If the blue bullseye applet does not load, please go to www.java.com to download

for FREE the most recent version of Java! Also, if you are a Mac user, please be sure
you are using the Safari web browser!
When you drag your images onto the blue bullseye, you small window will typically pop up saying
“Trying to Scale Images. Please Wait!” If this happens, do not worry. Online Galleries is only
confirming the sizes of the images. Another small window will also pop up after a few seconds
which will display a progress bar and tiny square thumbnails of your images as they are
uploaded. When that mini-thumbnail window disappears, you will still need to wait until the words
“Upload Complete” are seen beneath the bullseye window.
Once “Upload Complete” is displayed, you may click again on the “Gallery Control Panel” sub tab.
Click the blue link on the bottom of the page to view the Gallery you have just created.
Upload Images - Premium (New, Fully-Featured Uploader Tool)
For both Mac and PC users, the Premium uploader may resize your images according to the
Maximum Width and Height proportions defined in your Photographer Information form under the
Settings tab. If you do not want your images to be resized by the Online Galleries interface, you
should leave these fields empty.
For PC users with the Internet Explorer browser:
Images will upload according to their arrangement in the upload preview window. If you ADD
images to a Gallery that already contains images, the new images will upload by file name but be
located at the end of the Gallery. Added images will NOT be inserted in between existing Gallery
images, regardless of file name.
For PC users with the Firefox browser or Mac users with the Safari browser:
For faster upload time, you may also want to resize your images before uploading them. We
recommend that resized images should be constrained to between 300 and 700 pixels. Images
will upload according to their arrangement in the upload preview window. If you ADD images to a
Gallery that already contains images, the new images will upload by file name but be located at
the end of the Gallery. Added images will NOT be inserted in between existing Gallery images,
regardless of file name.
-Select the "Upload Images NEW!" button from within the Gallery Control Panel.
NOTE: If the uploader does not load, please go to www.java.com to download for FREE
the most recent version of Java! Java runtime version 1.4 or above is required. Also, if
you are a Mac user, please be sure you are using the Safari web browser!
-When/If prompted, accept the Java applet from Aurigma to initiate the uploader window.
-From the panel on the left, select the folder of images from which you would like to upload.
-The images from the selected folder will appear in the Selection Panel on the top right of the
uploader window.
-Hold down the Shift key while clicking with the mouse to select multiple images from the
Selection Panel, or click the "Select All" button.
-Images can be rotated in both the Selection Panel and in the Upload Panel by mousing over an
image and clicking a rotate arrow at the bottom corners of the image window.
-Captions can be added to images in both the Selection Panel and in the Upload Panel by
clicking the "Edit Caption..." link and typing your preferred text.
-Remove images from the Upload Panel by clicking the "Remove" or "Remove All" buttons.
-When all of your chosen images are in the Upload Panel on the botton right of the uploader
window, click the "Upload Now" button.
-A Progress Window will open, tracking the upload status.
-When the upload has finished, another window will open with the message, "Upload Complete!"
-Click "OK" and you will be re-directed to the Gallery Control Panel page to view your Gallery or
make changes.
5-Help Files and Tutorials
Following are the Online Galleries Help Files, as well as a number of Tutorials designed to give
step-by-step instructions for using certain Online Galleries features, and for preparing your

images for upload onto Online Galleries. You will find the following information:
A) Help Files
B) Optimizing Your Images for the Web Using Photoshop
C) Watermarking Tutorial

Online Galleries HELP FILES
INDEX
A)
B)
C)
D)
E)

SETTINGS
GALLERY
PRICE LISTS
REPORTS
PHOTOLYNX (Import/Export)

A. SETTINGS

The sub-menus within “Settings” will allow you to enter your contact information, the shipping
options you will offer, and customize the appearance of the opening page to your galleries.
PHOTOGRAPHER INFORMATION
“Photographer Information” is an option within the “Settings” sub-menu.
1. Enter your contact information, and select a “Username” and “Password.” You will use
these to log into your Online Galleries Administrative Pages.
2. “Logo Image” - Browse and select your logo from the files on your computer. You should
have created this logo prior to your Online Galleries training. If you need a Logo Creation
tutorial, contact Online Galleries.
3. “Footer Text” - Enter text which you would like your customers to see at the bottom of
each gallery page, e.g. “All Images Copyrighted”
4. “Thumbnail Size” - Choose the size thumbnails you would like to appear on your gallery
pages. “Large” thumbnails allow 5 across to be viewed without scrolling.
5. “Maximum number of images on a thumbnails page” - Choose the number of thumbnails
you would like to appear at one time on a single page.
6. “Number of images per row on the thumbnails page” - “Large” thumbnails allow 5 across
to be viewed without scrolling. “X-Large” thumbnails allow 3 across to be viewed without
scrolling. “Medium” thumbnails allow 6 across to be viewed without scrolling. “Small”
thumbnails allow 7 across to be viewed without scrolling.
7. “Maximum Image Width/Height” - Enter the maximum pixel size allowed for your full-size
images. When a customer clicks on a thumbnail, the full-size image that appears will be
no larger than these pixel constraints.
8. “Photo captions appear below images on thumbnail page?” - Select “Yes” if you would
like to display comments about each image on the thumbnail page. If you do not create
comments, none will be displayed, even if this box is checked.

9. “Check the image view options that will appear next to enlarged images in the gallery” Checking these checkboxes will allow customers to view an image in “Sepia Tone”,
“Black and White”, and/or “Touch of Color.” The image will be displayed in a new window
beside the original image, allowing for side-by-side comparison
10. “Tax State” - enter the state in which you collect sales tax
11. “Tax Rate” - enter the sales tax rate for your county. If you do not wish to collect sales
tax for online sales, leave this box blank. This feature will be set through PayPal if you
choose to use PayPal for processing your transactions.
12. “Watermark Disabled” - Select “Disabled” if you are already watermarking your images
using Online Galleries Image Processor, Photoshop, or any other image editing program.
13. “Watermark Enabled” - Select “Enabled” if you would like Online Galleries to
automatically add a watermark to your uploaded images.
14. “Watermark Image” - Browse and select the .PNG watermark file you created prior to
your training. If you need a Watermarking Tutorial, contact Online Galleries.
15. “Adjust the size of the watermark image to fill the picture” - Select this to ensure the
watermark resizes according to your selected image width. Watermarks do NOT adjust to
cover the entire image. They remain to scale.
16. “Default Price List” - Select the Price List which is compatible with the largest number of
your galleries. You may change any single gallery's price list later.
17. “Default Style” - Select the color scheme for your galleries. You may change any single
gallery's color scheme later.
18. “Show links to other galleries within a group” - Check this box if you would like your
customer to have access to all of the galleries contained within a single group, such as all
of your weddings, or all of your school photos. For security purposes, most
photographers choose to leave this box UNCHECKED.
19. Click “Update” to save your information and settings.

SHIPPING
Create customized shipping options for your customers to choose from.
1. Click on the “Shipping” text link in the “Settings” sub-menu
2. Click “Add Shipping Option”
3. “Shipping Name” - Title your shipping option, e.g. “USPS First Class” or “FedEx Express
Mail”. You may also wish to create a shipping option named “Pick-Up” if you allow your
customers to pick up their order from your studio
4. “Cost” - Enter the price (if any) you will charge for this shipping option
5. “Flat Rate” - Select “Flat Rate” if you will charge this price regardless of the size of the
customer's order
6. “Tiered” - Select “Tiered” if you would like to charge based on the order amount. E.g.
“Cost” $3 “Tiered : per amount of purchase” $50. In this case you will be charging $3 for
every $50 spent by your customer.
7. “Description” - optional – Describe in detail the shipping service you are providing, e.g.
“Shipping, Handling, and Insurance”, or “Pick up between 9 & 5 at 123 Anystreet USA”
8. Click “Add Another” to create another shipping option. Click “Finish” to return to the
“Shipping” main page. Click “Cancel” to delete your shipping option entry.

STYLES
The “Styles” sub-tab under the “Settings” tab allows you to create your own gallery styles by
customizing the colors and fonts.
1. Click “Add Style” to create a new style
2. “Name” - Name this Style so you can identify it later (e.g. “Fall Colors” or “Jane's Style”
3. “Primary Background Color” - Click on the color block to select your background color

4. “Secondary Background Color” - Click on the color block to select a color that
compliments the Primary Background Color and will appear below certain lines of text
5. Select the other color blocks and colors in drop-down boxes to customize the appearance
of your page
6. “Font Family” - Type in the name of the font family you wish to use (e.g. “Arial” or
“Verdana”)
7. Click “Save” to view a preview of your custom style and save the style in your Style
Gallery

CUSTOMIZE LOGIN PAGE
This is where you customize the appearance of the login page your customers will see when they
enter Online Galleries via your website or direct link.
1. “Photographer Gallery Page Text” - Enter any special comments you would like all of
your customers to see when they arrive at the log-in page, e.g. “Thank you for visiting
mystudio.com! Please call 888.888.8888 with any questions!”
2. “Photographer Gallery Page Image” - Browse and select an image you would like to
present on your log-in page. This file may be a single image, or a collage of images you
have created. This feature is especially useful if you do not have a website and you are
sending your customers to Online Galleries via direct link. Recommended file size:
400Hx600W pixels
3. “Select Photographer Information...” - These items correspond with the information you
entered into your “Photographer Information” page. Check the boxes of the information
you wish to share with your customers on your log-in page.
4. Click “Submit” to save your customized page. Click “Reset” to delete your customization
entry.

B. GALLERIES
Here you can create Folders, Groups, and Galleries for organizing your images. A Folder may
contain additional Folders, and/or it may contain multiple Groups. Groups contain only Galleries.
Galleries contain the images your customers will view online.
1. Click “Add Folder” and name the Folder (e.g. “School Photography” or “Weddings”)
2. Click “Add Group”
3. “Group Title” - Enter the identifying name for this “Group”, e.g. “Weddings” or “Jefferson
High School”
4. “Password” - optional - Select a password. The password will NOT be used by
customers who are logging in to a specific gallery. The password MAY be used if you
choose to allow all of the “Jefferson High School” students to view one another's
individual image galleries.
5. “Expiration Date” - optional - Enter an expiration date only if you wish this entire “Group”
to expire
6. “Event Homepage Text” - optional – Enter a greeting or comment you would like to share
with anyone who logs in to this “Group”, e.g. “Welcome Jefferson High School Students.
Select a gallery to view images.” If you will NOT be allowing customers to view galleries
other than their own, you do not need to enter any of the optional information.
7. “Show Links to Other Galleries Within Group” - Check this box if you will be allowing
customers to view galleries other than their own personal gallery.
8. Click “Add” to save this “Group”. Click “Cancel” to delete your “Group” entry.
NOTE: A Group may be added outside of a Folder. Groups may be moved into Folders at any
time with the “Move Selected Groups to Folder:” feature.

GALLERY
1. “Add Gallery” - Click to create a “Gallery” within the “Group” you just created

2. “Gallery Name” - Title the “Gallery” for your customer, e.g. “Beth Brown's Photos”
3. “Password” - Select a private password for use should you choose to privatize this
“Gallery”. Your customer will log-in to their “Gallery” using this “Password”
4. “Job Number” - optional – Assign a “Job Number” to this “Gallery” (optional)
5. “Expiration Date” - Click on the calendar icon to select a date for “Gallery” expiration.
Subscribers may leave a “Gallery” active for as long as they choose. Pay-As-You-Go
users may leave a “Gallery” active for 90 days.
6. “Event Date” - optional - Click on the calendar icon to select the date the photographs
were taken
7. “Venue” - optional – Enter the name of the “Venue” where the photographs were taken
8. “Gallery Homepage Text” - optional – Enter a message or commentary you would like
your customers to see when they log-in to their “Gallery”, e.g. “It was a pleasure to work
with you! Best wishes!”
9. “Home Link Name” - optional – You may choose to create a link to a website associated
with your client, e.g. Jefferson High School
10. “Home Link” - optional – Here you enter the www link associated with the “Home Link
Name” you entered above
11. “Price List” - Choose the “Price List” you would like to associate with this “Gallery”, e.g.
“Wedding Price List”

C. PRICE LISTS
Create and store multiple price lists for varying jobs. Each price list can be associated with your
lab/product costs to help you track your profits and costs.

PRICE LISTS
Now you may begin to create your “Price List”.
1. Click “Price Lists” in the menu bar to begin
2. Click “Add Price List”
3. “Price List Name” - identify your “Price List”, e.g. “Wedding Prices” or “School Photo
Prices”
4. “Price List Type” - Choose the “Lab Products” list you would like to associate with this
“Price List.” Your lab may offer one or more “Lab Products” options.
5. “Shipping Options” - Select the “Shipping Options” you would like to associate with this
“Price List.”
6. Click “Add” to create the “Price List”. Click “Cancel” to delete your entry.
7. “Product Name” - the identifying title of the item you are selling, e.g. “8x10”
8. “Field Type” - Select “Print or Product” for tangible items which you are selling. Select
“Print Enhancement” for actions which are done to a product. Select “Text” to create a
line of text which will be inserted into your “Price List” for your customers to view. Select
“Customer Text Entry Box” to create a date box in which your customers can type special
instructions, etc.
9. “Retail Price” - Enter the price you will be charging your customer
10. “Lab Product Price” - Select the “Lab Product” you would like to associate with this
product (if applicable)
11. “Description” - optional – Describe a product to your customer
12. “Sample Description” - optional – Only enter a “Sample Description if you are going to
upload a “Sample Image”, allowing your customer to view a sample of the product
13. “Sample Image” - optional – Browse and select an image from your files which will show
your customer what this product looks like
14. Click “Add Another” to add more products. Click “Finish” to return to “Price Lists.” Click
“Cancel” to delete your “Price List” product entry.

You may edit a “Price List” at any time by clicking “Edit Products.”
You may edit the “Price List” Name, Type, or Shipping Options at any time by clicking “Edit.”
You may copy a “Price List” at any time by clicking “Copy.”
You may remove a “Price List” at any time by clicking “Delete.”
Learn about building and associating Packages in the “Package Builder” portion of this Guide.

D. REPORTS
Your “Reports” administrative pages allow you to view all cost and payout information for all of
your “Galleries” and “Groups”

GALLERY SIZE
“Gallery Size” is a text link within the “Reports” sub-menu. It gives you data such as: Create
Date, Expire Date, total number of Orders received for each gallery, total number of Images
existing in each gallery, and the amount of storage space your existing “Galleries” are consuming.
You may also delete entire galleries by checking the box beside the gallery you wish to delete.
ORDERS
“Orders” is a text link within the “Reports” sub-menu. It requests a “Start Date” and an “End Date”
and will generate reports information for the time period between these two dates. “Orders
Report” give you data such as: Order ID for individual orders placed, Customer names, Total
amount of each sale, Tax applied to each sale, Shipping applied to each sale, Lab Cost
associated with each sale, the Date of each sale, the Type of “Product” ordered, Gallery from
which the order was placed, date Shipped.
You can also view your Overall Total dollar amount for all orders, the Tax Total dollar amount for
all orders, the Shipping Total dollar amount for all orders, the Transaction Fees charged to you for
all orders, the Lab Cost Total for all orders, and the total Photographer Payout.

ORDERS BY GALLERY
“Orders By Gallery” is a text link within the “Reports” sub-menu. It requests a “Start Date” and an
“End Date” and will generate reports information for the time period between these two dates.
“Orders By Gallery” gives you the same data as is generated within the “Orders” report, but it is
separated by each individual “Gallery”. You can also view the number of Hits for this gallery, the
dollar amount of Credit card sales, and the dollar amount of Non-Credit card sales.
Here you may also download customer information for all orders, or only the orders which have
not yet been shipped.

ORDERS BY GROUP
“Orders By Group” is a text link within the “Reports” sub-menu. It requests a “Start Date” and an
“End Date” and will generate reports information for the time period between these two dates.
“Orders By Group” provides you with the same data as “Orders by Gallery”, only organized by
“Group”.
PRINTS ORDERED
“Prints Ordered” is a text link within the “Reports” page. It requests a “Start Date” and an “End
Date” and will generate reports information for the time period between these two dates. “Prints
Ordered” provides you with data regarding all image numbers and sizes that have been ordered.
LOG FILES
“Log Files” is a text link within the “Reports” page. It displays information regarding visitors to
your Click and Safe galleries.
PICTURE CREDIT HISTORY
“Picture Credit History” is a text link within the “Reports” page. It logs all Picture Credit activity,
including Picture Credits Purchased, and Picture Credits Used.

E. PHOTOLYNX
CamLynx users should select “Import” for uploading their images. CamLynx is an on-site capture
and data collection system which uses professional digital cameras to produce a multitude of
products for event, school, and sports photography.

HELP
The “Help” pages will provide you with the ability to submit technical support requests as well as
browse our online help manuals.

CONTACT TECHNICAL SUPPORT
“Contact Technical Support” is a text link within the “Help” sub-menu. Select the type of support
you are requesting (General, Emergency, Feedback/Enhancement Request), then enter your
request into the Message box. Click “Submit”.
Online Galleries HELP
“Online Galleries Help” is a text link within the “Help” sub-menu. Use the index to find the “Help”
topic you would like to read.

Web-Optimize Images with Photoshop

Create a Photoshop Action : Resize & Rename
NOTE: Details of the instructions below may vary slightly according to the version of
Photoshop you are using, or the computer you are on (Mac or Windows). Please refer to
Photoshop help files for further instructions specific to your system.
FIRST: Create a Online Galleries folder on your desktop!
1.

Open the “Actions” window from the “Window” tab in your menu bar.

2.

Select the paper-shaped “new action” icon from the bottom of the Actions window
to create a new Action.

3.

Call the Action “Fit Image for Online Galleries.”

4.

Select the circle-shaped “record” icon from the bottom of the Actions window.

5.

Open an image you would like to resize.

6.

Select “File” > “Automate” > “Fit Image” from the Photoshop menu bar.

7.
Enter your “Constrain Within” pixel dimensions. We recommend that both the
“Height” and “Width” boxes contain the same pixel amount so as to make each image the
same size, whether vertical or horizontal. (This will NOT make your images square!) Most
photographers resize their images to fit within 350 to 600 pixels, though you may choose a
larger or smaller size if you prefer.
8.
Click “OK” and the image will be resized. Zoom in to 100% to view the image as it
will appear within the Online Galleries Gallery.
9.

Select “File” > “Save As” from the Photoshop menu bar.

10.

Save the image to the Online Galleries folder you created on your desktop.

11.
Close the image. IMPORTANT: Select the square-shaped “stop” icon from the
bottom of the Actions window!!!!
12.
Now you can run a “batch action” on all of the images you would like to resize for
Online Galleries.
13.

Select “File” > “Automate” > “Batch” from the Photoshop menu bar.

14.

Select the “Fit Image for Online Galleries” Action you created.

15.

Select the folder which contains the images you would like to resize.

16.
Check the following boxes: “Override action OPEN commands”, “Suppress File
Open Options Dialogs”, “Suppress Color Profile Warnings.”
17.
Select destination “Save and Close.” Your images will be saved to the location
defined in the Action you created. If you would like to save your images elsewhere, check
the box: “Override Action SAVE AS Commands” and enter your saving preferences as
prompted (choose your destination folder, and select your image renaming preferences).
18.
Click “OK” to run the Action. Each image within the chosen folder will be opened,
resized, and saved to your chosen destination. The original files will remain in their
original location.

19.
The Online Galleries folder and it’s images may now be dragged onto the Online
Galleries
bullseye for upload
NOTE: These instructions have not been approved by Photoshop
and are not intended to train anyone in the use of Photoshop. For more detailed
information on Photoshop and its capabilities, consult the “Help” tab from the Photoshop
menu bar. This method is only one of the many ways by which an individual may resize
and/or watermark images for Online Galleries. Online Galleries is not responsible for
providing web optimization training and offers this “cheat sheet” tutorial as a courtesy.

Batch Process : Photoshop Elements 2.0
Resize and Rename

1.

Select “File”, “Batch Processing” from the menu bar in Photoshop Elements

2.

“Files to convert” : Select the folder of files you wish to convert

3.

“Conversion Options” : Select the file type to which you are converting your
image files (JPEG Low, Medium, High, or Max)

4.

Check “Convert Image Size” box and enter the pixel dimensions you prefer for
the large images on your gallery (standard is between 350 and 450). Enter the
same pixel dimensions in both the Width and Height boxes. Set the Resolution to 72 dpi.
5.

Check “Rename Files.” Enter your preferred information. Do not check the “MAC
OS 9” or “Unix” boxes.

6.
“Output Options” : Click the “Destination” button to choose your destination folder
for the resized/renamed images. IMPORTANT: You must copy your image files to a folder
other than the original folder or the original image files will be affected!

WATERMARKING : CREATE A .PNG FILE WITH PHOTOSHOP

1. Open Photoshop. Select “File” >> “New”

2. Create a New canvas sized 300
pixels wide by 100 pixels high. The resolution should be 72 pixels/inch. The background
MUST be TRANSPARENT. Now click “OK” and your new canvas will appear on your screen.

3. Select “Window” >> “Layers”. A “Layers” dialog box will
appear in the lower right corner of your screen. This will allow you to customize the appearance
of your watermark.

4. Select the “T” (Type) tool from your toolbar.

5. Choose WHITE as your text color
from the color block in the menu bar across the top of your screen.

6. Select your font. Choose a strong, bold font which
will be easy to read. Avoid heavily serifed and scripted fonts. Now place your curser over the
canvas you created and CLICK. This will activate the text tool. Type your watermark text now.
We suggest that your watermark text say “COPYRIGHT 2005” or “WWW . YOURSTUDIO .
COM”.

7. In your “Layers” window, select the “Opacity” slider and reduce the
opacity to 45%. This will allow your image to be viewable through your watermark text.

8. Now select “File” >> “Save As” to save your file.

9. The “Save As” window will open in
the center of your screen. Name your file, select the location to which you would like it to be
saved, and choose “Format: PNG (*.PNG)”.

10. Specify the PNG watermark image you
created as the “Watermark Image” in the Online Galleries Photographer Information form
in your Settings page. Now, when your customers view their photographs online, they will
see an image that looks something like this. You may choose to lower or raise the
opacity, or to choose a thinner or thicker font.

CUSTOMIZE LOGIN PAGE

Login to Online Galleries Account >> “Settings” Tab
>> “Customize Login Page” Subtab
Customer Login Page Text : Enter text you would like to appear on your Customer Login Page.
This text will be viewed by anyone who is logging into a Gallery you have posted.
Customer Login Page Image : Browse and attach an image you would like to appear on your
Customer Login Page. This image will be viewed by anyone who is logging into a Gallery you
have posted. This image may be as small or as large as you choose, though we recommend an
image no larger than 600 pixels wide. You may need to experiment with different pixel
dimensions in order to get the effect you are trying to achieve. This image may be a single image
or a collage of images in a single canvas saved as a JPEG file at 72 dpi.
Select Photographer Information fields that will appear on your Customer Login Page :
Address, Primary E-mail, Phone, Secondary E-mail, Cell, Website, Fax, Footer Text.
By checking the boxes that appear beside each option, you determine which pieces of
information will be displayed to anyone who is logging into a gallery you have posted. This
information is taken from the data you entered into your “Photographer Information” page under
the “Settings” tab.
You must click on the “Submit” button in order for your changes to be saved!

BROWSE AND ATTACH LOGO IMAGE
Login to Online Galleries Account >> “Settings” Tab >> “Photographer Information” Subtab
>> text entry box below Name information
Logo Image : You may browse and attach a logo image that will be displayed on every Online
Galleries page that is viewable by your customer.
This logo should be no more than 100 pixels high, as it may affect the appearance of your pages
in a negative way if it is larger than the recommended dimensions. The logo image should be a
72 dpi JPEG file. You will probably want to make certain that the background color of your logo
matches the background color of your Online Galleries pages.

CUSTOMER NOTIFICATION E-MAIL

Don't forget to notify your customers that their event's images are online and available for viewing
and ordering! If you're at a loss as to what to say, feel free to use our sample e-mail below:
SAMPLE WEDDING LETTER
Dear Smith Wedding Attendees,
Jones Photography's photographs from the Smith Wedding are now available online! Log on to
order reprints and share John and Rebekah's memories of their wedding day!
www.jonesphotography.com
Click “View Photos Online”
Password : smithwedding2005
If you have any questions, concerns, or special requests, please contact the photographers at
Jones Photography. We will be happy to assist you in any way we can!
-Jones Photography
info@weddingphotography.com
888.555.1010

SAMPLE SCHOOL LETTER
Dear Jefferson College Students,
Pro School Photography's photographs from the Spring Banquet are now available online! Log
on to view the photos and order reprints!
www.proschoolphotography.com
Click “Online Proofs”
Password : jeffersonbanquet007
While you're online, don't forget to take a look at the other Jefferson College galleries, including
the New Years Ball and the Family Weekend Event. Links to these galleries are located at the
bottom of the Spring Banquet welcome page.
If you have any questions, concerns, or special requests, please contact the photographers at
Pro School Photography. We will happily assist you in any way we can!
-Pro School Photography
info@proschoolphotography.com
888.555.2424

7-Flash Websites
Flash Websites are available to ALL Online Galleries members! Online Galleries Subscribers

may use their Flash Website completely free of charge.
members may be charged a small monthly fee for access.
Flash Websites are editable, flash-based websites.
Galleries's powerful, secure servers.

Online Galleries Pay-As-You-Go

They are hosted from free on Online

Following are steps to assist you in activating your Flash Website, as well as tips for designing
your Flash Website and adding content.
ACTIVATE YOUR Flash Website
Click the “Enable Flash Website” button located under the “Home” tab in your Online Galleries
account. Pay-As-You-Go members will be prompted to allow Online Galleries to bill their credit
card each month for use of the Flash Website.
CREATE YOUR Flash Website
Begin creating your Flash Website by clicking the “Flash Website Control Panel” button which will
now appear where the “Enable Flash Website” button once existed.
Each Flash Website is comprised of THREE parts:
• Flash Website Control Panel
• Galleries
• Website Content
Throughout the Control Panels you will see red text: e.g. “Maximum dimensions 730 x 100.” This
represent the size, in pixels, of the canvas you should create in Photoshop on which to lay your
logo, images, etc. The full recommended number of pixels should always be used to ensure your
designs appear on the site as you intend. All files should be high-quality JPG.
Flash Website Control Panel
• Update Logo: Broswe and attach your Flash Websites logo image.
• Update Main Picture: Similar to the Online Galleries “marquee image”, the Main Picture can
be a single image, or a “collage” of images laid out in Photoshop.
• Site/Business Name: This text will appear in the menu bar of your customer's browser.
Search engines may also access bits of this text to bring your website up during a search.
Many photographers choose to enter information such as: “ABC Photography – Sports
Photography for Atlanta, GA”
• Online Gallery Link Name: This is the title of the link through which your customers will access
their online image galleries provided by Online Galleries. You may choose to name this link
“Proofs” or “Order Photos” or “View Images.”
• 1st/2nd/3rd Portfolio Gallery Name(s): E.G., “Weddings”, “Babies”, and “Seniors”
• Foreground Color: Text color
• Background Color: Primary website colors
• Always click “Save My Information” whenever you make changes!
Galleries
Add images to your portfolios through this panel. Be sure to use the recommended sizes for the
main images and for the thumbnail images.
Website Content
Click on one of the web page titles to update that link. Sample images and text are already
provided by default.
• Image: This JPG file may be a single image or a collage of images created in Photoshop. The
entire file must fit within the Maximum Dimensions.
• Title: This text will appear as the text link on your page. Your customer will click on this text
link to navigate to the page.
• Content: Enter the information you would like to appear on the page.
PLEASE NOTE:

Mac Users: MUST use the Safari, Camino, or Firefox web browser when making changes to their
Flash Website through the Flash Website Control Panel.
Text Editing: MAY work differently on a Mac versus a Windows computer.

